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I GUI OVERVIEW
1. Important
The GUI is fully open source.
For questions regarding data acquisition, installation and use of the GUI, or the obtained results,
you can send an email to isabelle.clery@ign.fr.
For any use (in test or production), please send an e-mail at the same address to give me an
overview of the uses, to help me to focus devlopments on the wished features or on actual
applications, and to report bugs.
In any publication using the GUI, please cite the MATIS laboratory (Université Paris-Est, IGN,
Laboratoire MATIS, 73, avenue de Paris, 94165 Saint Mandé,
http://recherche.ign.fr/labos/matis/accueilMATIS. php).

2. Principle
InterfaceMicmac is a graphical user interface for a set of tools developed by the MATIS laboratory
for processing photogrammetric projects.
It allows the entire treatment of a project in a simplified and fully graphical way, including:
•

extracting tie- points from image pairs (tool Pastis)

•

estimating camera poses (tool Apero)

•

creating depth maps and orthoimages (MicMac tool) that can be converted to 3D points
clouds, textured mosaics of orthoimages and shaded depth maps.

Please note that some projects can not be processed through the GUI because of the parameters
simplification.
In this case, different tools are available at : http://www.micmac.ign.fr/svn/micmac/ (documentation
is in : Documentation/DocMicMac/DocMicMac.pdf).
The GUI is a free, open-source software that works on Linux and Mac OS, that do not require any
Internet connection during its use, and that can be download either as a zip file or with svn software.

II INSTALLATION
To install the GUI, just download the zip file for your OS from the folder
http://www.micmac.ign.fr/svn/micmac_data/trunk/DocInterface/ : choose between Linux32bits.zip,
Linux64bits.zip and Mac.zip.
The contents of the downloaded folder is detailed below.
The GUI should always be run via a terminal that displays the errors. In addition, the GUI must
have the rights of the parent folder of the console.
To start the GUI, double-click the launcher lanceurInterfaceMicmac and select "run in terminal". To
access it from another folder, copy the launcher, open it in a text editor, change the line "cd ./" with
"cd GUIFolder", and type in the terminal "chmod + x newFolder /lanceurInterfaceMicmac."
Spaces and special characters should be avoided to the maximum ("-" and "_" are not a problem) in
the folder names (full paths), even if spaces and special characters (usually) run.
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1. The GUI
It includes:
•

the executable file interfaceMicmac,

•

documentation doc.pdf,

•

databases (BDCamera.xml, xml directory)

•

online help files (help.qhc and help.qch, directory help) and the program assistant for
reading them (help/assistant)

•

program tiff2rgba (lib /).

•

program convert (lib /).

2. Associated binaries
The GUI uses a set of tools that must be installed in a directory called micmac/bin/ of which the
user has directly the rights.
Used binaries are:
•

MyRename

•

Devlop

•

tiff_info

•

MapCmd

•

ElDcraw

•

MpDcraw

•

Pastis

•

test_ISA0

•

Bascule

•

Tarama

•

Apero

•

MICMAC

•

GrShade

•

Nuage2Ply

•

ScaleIm

•

Porto.

And two other programs placed in the folder micmac/binaire-aux:
•

siftpp_tgi.LINUX (or siftpp_tgi.OSX for Mac)

•

ann_mec_filtre.LINUX (or ann_samplekey200filtre.OSX for Mac)

3. Libraries and other required binaries
Tools mv, sh, and make (already installed by default for Linux). On Mac OS the Apple Devloper
has to be installed.
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There is no need to install the Qt libraries, however, depending on the version of Linux, there may
be a problem with the library version of libc. In this case you need to install Qt and use the
executable with dynamic links (see the READ ME file).

III USE OF THE GUI
1. Beginning
The GUI do not require any Internet connection. However, before surveying, do not forget to serach
for the sensor size or the pixel size of the camera (see part Tie-points search), to check out if Qt
libraries are needed, and in general to test entirely the GUI (including data acquisition protocol). Do
not hesitate to use the “hotline” for any question or if a bug occurs.
To get the English version, see part GUI global settings.

a. GUI menus
The GUI opens with the above main window. There following menus are available :
Project management :
−

File → Open a computation file : loads the parameters of a project whose treatment began
in a previous session and was saved

−

File → Load images : loads all the images of the project ; start with this menu

−

File → Save et File → Save as: saves all the parameters of the project and the progress of
treatment, which allows to go back later to the exact calculation

−

File → Quit

Processing :
−

Compute ->Tie-points search : converts images to TIF format, creates or imports initial
calibrations and searches for tie-points between images ; this is the processing first step

−

Compute → Poses estimation : computes aerotriangulation and re-estimates calibrations ;
this is the processing second step

−

Compute → Deth maps computing : computes depth maps (they are images of which the
third dimension is known for each pixel) ; this is the processing third step
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−

Compute → Restart: restart an interrupted processing

Results display at each step :
−

View → Tie-points view : shows the computed tie-points in pairs of images

−

View → Survey view : displays dynamically in 3D the oriented cameras and the obtained
tie-points

−

View → Points clouds view : displays in 3D the computed depth maps as points clouds

Depth maps export :
−

Conversion → 8 bits depth maps : converts each depth map in a 8 bits tif image that
represents the model with shading and hypsometric colors

−

Conversion → Orthoimage : converts each depth map in a mosaic of orthoimages with
hidden parts management

−

Conversion → 3D models : converts each depth map in a points cloud in *. ply format

Help and GUI global settings :
−

About : GUI presentation

−

Help: on-line help

−

Options : GUI settings (see below)

−

Computing checkout : only accessible during depth maps computation ; this window
allows the user to check that the calculation is going well and to stop it if it is not the case

−

Directory clean-up : removes from the data directory all useless files ; it is useful especially
after depth maps computation

b. Main window and launching of the GUI
The main window shows the progress at each stage of the processing.
The different steps of the calculation must be processed sequentially to ensure data coherence.
In each window, the button

provides access to the correspoonding online help section.

Most of the required parameters are pre-filled with a default value.
On Linux, the executable must be run from a directory of which the user has directly the rights
as well as those of the parent directory, otherwise an error message appears. Using the launcher
lanceurInterfaceMicmac solves this problem.
If the prompt indicates that the user does not have the rights to launch the software, select the
executable interfaceMicmac, right click, Properties, Permissions and check "Allow executing file as
program". Check as well that the other binaries have the required authorization.
Note about the data directory:
−

All data should be in the same directory.

−

The results will be recorded in that directory. Don't forget to put all your data in a new
folder before running the GUI if you want to keep your directories clean.

−

Should be avoided to the maximum spaces and special characters in folder names (full
paths) and files (even if the spaces in the files and some special characters are handled).
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c. GUI global settings
Some global parameters of the GUI can be set up with Help → Options :

−

Micmac directory, where are located the associated binaries, is searched in the whole system
when you start the GUI for the first time (the nearest to the GUI directory is selected) ; then
the path is stored in the GUI internal parameters in order to not look for it at every
launching. The GUI also warns the user if some binaries are missing in micmac folder. If the
found directory is not correct (the path is written in the command prompt at startup), this
window lets you specify the right directory.

−

The GUI can be in English or French, the default language is the one of the system (or
French if the system is in another language).

−

The processing is mainly performed in parallel using multiple processors of the machine.
The number of used processors is by default the number of recognized processors of the
machine, but it may be useful to reserve one or two to not freeze the screen or to launch
other applications.

−

An editable database stores the pixel sizes of used cameras (see part tie-points search). It is
written in the xml/BDCamera.xml (also editable).

2. Load images
From the main window, select File -> Load images.
Images must be in raw, jpg or tif format, or a mixture of them, and can be imported in multiple
times as long as no calculation has been made.
Accepted raw formats are : 3FR, arw, crw, dng, kdc, mrw, nef, orf, pef, ptx, raf, x3f and RW2.
Some compressed jpg images can not be read. In this case the error "Fail to convert the images
to tif format" will appear (see also in the terminal which image it is). In this case, you have to
convert images to TIF format using another software (eg convert) and then import these tif images.
Tif images are then renamed with the focal length read from the meta-data. If the focal length is not
indicated in the meta-data and multiple calibrations are possible (see Tie-points search), you must
rename the images by including the name of the lens.
It is not possible to compute 2 different calibrations with the same focal length (except for focus
modifications for a single objective). This is because the calibration files are automatically
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associated with the images by comparison of their focal length. If your images come from 2
different cameras, make sure that different focal lengths have been used.
Finally, the automatic execution requires that all images have a different name (without extension).
The list of images is displayed in the main window and updated at each stage of the calculation.

3.Tie-points search
From the main window, after importing images, Compute -> Tie-points search
opens a secondary window for entering the parameters of the survey.
If tie-points have already been calculated before, they will be deleted.

a. Add initial calibrations of the camera

An initial calibration is required for every used objective ; as a reminder, the list of the used
objectives is displayed above the frame (these focal lengths are extracted from images meta-data).
If the initial calibrations are already defined in xml files, load them by clicking on button
The recognized format is the following :

where :
PP is the principal point,
F is the focal length in pixels,
SzIm is the images size (width height),
CDist is the distortion centre,
CoeffDist are the coefficients of the distortion polynomial (r3, r5, r7 et r9).
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.

To automatically process the data, calibration files must be in the data directory and their must end
with the focal length in mm ; if it is not the case, they will be copied in this directory.
If a calibration is not defined, create it with the button

.

The user can create a calibration for a fish-eye or for a “classical” objective (conical).

Only the focal length and pixel size (or sensor size) are required values.
The sensor size can be found in the manual of the camera or on the website www.dpreview.com/
which lists most cameras (topic specifications, select the manufacturer and the camera, the
requested size is the longest one given by the line "sensor size"). The GUI then automatically
calculates the pixel size from the size of the sensor.
If the camera is stored in the database of cameras (see Options), just select the camera to get the
pixel size.
These two parameters are used to have on the one hand the focal length in mm in order to
automatically associate the images to the proper calibration, and on the other hand a calculated focal
length in pixels to initialize the calibration ; the entered pixel size can be computed so that the GUI
determines an equivalent focal length.
By default, the distortion is set to zero, the main points are the center of the image and the radius is
set to the half diagonal of the image. The GUI accepts most formats of distortion coefficients.

9/55

Calibration parameters are in all cases (re)calculated during the poses estimation. However, it is
advised to provide a fine enough initial calibration for the fish-eye lenses to avoid calculation to
diverge.
Then confirm the new internal calibration with the button

(or cancel with the button

).

The internal calibrations imported or created are listed above the form.
The internal calibrations are automatically associated with corresponding images, it is important to
define a calibration for each lens used.
Note: The GUI does not include images taken with two different devices of the same focal length.
One method may be to define two calibrations of different focal lengths of 1 mm (so as not to
diverge the calculation) and rename the images with the focal length of the correct calibration (in
order to associate the images with their calibrations).
It is possible to delete a calibration of the list with the button

.

Next ..
Click on button Next

b. Select the shooting type

Select the shooting type :
−

convergent : all the shots converge to the same point ;

−

parallel : all shots are oriented in the same direction.

This choice simplifies the entry of the following parameters.
Next .
After selecting the shooting type, click on Next

c. Select images pairs
This tab appears in the case of a convergent shooting. In the case of a parallel shooting, it is difficult
to list pairs of images that partially overlap due to intra-band overlap ; that's why all the image pairs
are selected.
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Select the images pairs in which tie-points are searched.
To select all the couples, click on button , then choose "Select all couples." If the survey includes
many images, do not select all the pairs, the calculation could be long and the computer running out
of RAM.
To select all adjacent pairs of images (including cases of full rotation around an object), click on the
button , then select "Select the k closest pairs" :

Choose how many successive images will be matched with each image and click on “ok”.
Depending on the configuration of the survey, it may be preferable to select the couples one by one:

•

select the first image of the couple in the left list,

•

select the second image of the couple in the right list (only the images that are not already
paired with the left one are displayed)

•

click on the button

to add this couple.

To add all the possible couples associated with an image, select it from the list on the left and click
on .
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The list of selected pairs is displayed in the tree on the right.

To delete a couple, select the second image in the tree and click on the button
couples associated with an image, select it as the first image in the tree).
To remove all couples click on

(to remove all the

.

Next ..
After selection of image pairs, click on Next

d. Set up the other parameters

The size of the rescaled image corresponds to the maximum width of the subsampled image in
which the tie-points will be searched ; this speeds up the calculation and reduces the number of tiepoints. It must be a non-zero integer.
If many couples have been selected, it is possible to perform this calculation in two steps (select
"Multi-scale"):
•

Tie-points are searched for the first time in all pairs of images that are rescaled at a low
resolution

•

Then again only on couples in which enough tie-points were found during the first step (the
selection criterion is determined by the "Minimum number of tie-points") and using a higher
resolution.
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This allows to keep only overlapping couples and thus eliminate some wrong tie-points.

e. Process running
Compute .
If all parameters have been filled, click on Compute
The calculation includes:
•

raw and jpg images conversion to tif format,

•

created calibrations writing and initialization,

•

tie-points computation for selected pairs of images.

Stopcomputation
computation in the
If the calculation is too long, you can stop it by clicking the button Stop
progress window. The parameters values and the calculation progress are then saved to allow the
process restart at the same point.

f. Results
Images converted to tif format are listed in the main window with their associated calibration file.
The results are in directories Homol and Pastis:
•

computed tie-points are ranked by pair of images in the *. dat and the *. result files,

•

used rescaled images in *. tif format.

Jpg and raw images have been moved to the directory Images_brutes.
Other created files contain provided settings:
•

created calibrations files,

•

the list of tif images : Liste_images.xml,

•

the list of couples : Liste_couples.xml

•

the list of calibration files to use : Liste_calibrations_internes.xml

•

the default settings depending on the shooting type : MicMac-LocalChantierDescripteur.xml

You can display graphically the found tie-points (see Tie-points view) ; this is especially useful if
the poses estimation does not converge to check if the images are connected together with tiepoints.

g. Frequent error messages
You have to start the GUI with a terminal to see which image causes an error and if there were
problems before the fatal error.
“An image has no associated calibration.” : Check that there is a calibration file for every used
objective, otherwise you have to create one. To do that, just look for images with no associated
calibration file in the main window. If it's a tif or jpg image, the metadata may not be readable ; in
this case the image should be renamed by adding the correct focal length at the beginning of the
name (for example, img_4625.tif becomes F035_img_4625.tif with a 35mm focal length).
“Fail to convert an image to tif format” : it is a compressed jpg image, it may not be readable by
the used libraries ; in this case it is better to convert it to tif by another program (convert or gimp for
example) and to load the converted image in the GUI.
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4. Compute poses
From the main window, after getting tie-points, Compute -> Poses opens a secondary window for
entering the parameters of the poses.
If the poses have been previously calculated, they will be deleted for the saving file (the results are
kept until new poses calculation).
The calculation includes the relative orientation (the images relatively to each another), the absolute
orientation (the whole site) and the re-estimation of calibrations for each objective.
To start computation quickly, keep all default parameters and change them back if a problem
occurs.

a. Select images to orientate

Images to orientate must be put in the top list, the others in the bottom list.
By default all are selected, but if the calculation fails once due to a problem of sequencing (too few
tie-points between two images blocks), it may be useful to divide the site into several blocks of
images and to run the process on one block at once.
To add images to orientate, select them in the bottom list and click
To not orientate some images, select them in the top list and click
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.
.

b. Select master image

If no absolute orientation is defined in the next tab, the master image is the image from which all
other images will be oriented (its position is the origin of the frame and the rotation of the camera is
the identity). Its choice simply allows to set an overall direction of the site which will facilitate
visualization.
In addition the images orientation is done in two steps:
•

First, the images are oriented one by one relatively to the master image, the priority is
determined by the number and distribution of the tie-points,

•

Then all initial orientations are adjusted iteratively at the same time.

To ensure the convergence of processing, the master image must be part of a block of images that
are linked with a lot of tie-points (usually the image that is the closest to the center of the site is
chosen).
An overview of the selected image is displayed below the list.
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c. Absolute orientation

The absolute orientation can be defined in five ways:
•

“Relative orientation” : the master image pose defines the orientation and the origin of the
frame ; the base (distance between the tops of shooting) between the master image and the
next image (found using a tree built from the tie-points) defines the scale (base = 1) ;

•

“User orientation” : a plan, a abscissa axis and/or a scale, that must be drawn in the images,
define a global orientation ;

•

“Absolute orientation of an image” : an image, whose orientation is already known from
an independent calculation, and a scale define the global orientation ; this allows to link this
project with an other project ;

•

“Georeferencing with GCP” : a set of ground control points (points whose both images
and terrain coordinates are known) define a precise georeferencing.

•

“GPS coordinates of pose summits” : summits and possibly orientation of the camera
poses are known and give an approximate initial georeferencing.

USER ORIENTATION :

You have to define a global rotation or scale or both. To do that select the type of parameters to be
fixed ; not selected parameters are by default those of the relative orientation (orientation according
to the master image pose and scale computed from the base).
The rotation is itself defined by a horizontal plane (which gives the vertical axis) and a direction in
this plan.
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To set the horizontal plane, you must draw a mask of this plan on an image. To do this, it is possible
to create one:
•

select the image in which the mask will be sketched and click on

•

select "create a new mask,"

•

sketch the mask (see part Using the mask drawing window)

•

validate the mask by clicking on
_MasqPlan.tif.

,

in the drawing window, the mask is saved as "image" +

It is also possible to import an existing one:
•

select the image in which the mask has been sketched and click

,

•

select "open an existing mask,"

•

... next to "Mask".
import the mask (in *. tif format) by clicking the button ...

It is possible to modify the mask by clicking on "Modify Mask".
The mask must contain tie-points which set up a mean plane defining the horizontal plane ;
otherwise an error occurs during the calculation.
To set the direction of the frame, you must enter two points of this axis in the images :
•

select the two images in which these points will be drawn (this can be twice the same)

•

click
and select 2 points in the images (one in each image if there are two), the tools are
the same as in the previous window,

•

validate the segment by clicking
clicked are shown below,

•

define which direction is pointed out by the drawn segment ; by default the drawn direction
is the x axis.

in the drawing window, the coordinates of the points

To set a scale :
•

you must have photographed a leveling staff or a tape measure with at least two images of
the site,

•

or you must know the size of an object seen in at least two images,
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•

otherwise, in the case of two image blocks of the same survey, that are calculated
independently but which must be put in the same scale, you must identify an object that is
common to both blocks and assign it the same size.

To set the frame scale, you must enter a segment in 3D, that means two segments drawn in two
images or pairs of different images :
•

select the four images in which these points will be entered (each segment can be selected
from one or two images, depending on its length), as follows:

image segment 1 point A
image segment 2 point A

image segment 1 point B (this may be the same)
image segment 2 point B (this may be the same)

•

click
and draw 4 points in the images (two in each frame if there are two), the tools are
the same as in the previous window,

•

validate the segment by clicking
segments are displayed below.

•

enter the actual distance of the segment.

in each drawing window, the coordinates of the clicked

The user orientation accuracy depends on the accuracy of the different segments drawing, and
it can not be as precise as georeferencement with a set of GCP but may be useful to consider the
accuracy of the final result (including noise) .
ABSOLUTE ORIENTATION OF AN IMAGE :
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This choice allows to connect two blocks of images of the same site with a shared image but that
are processed separately.
•

select the shared image

•

enter the parameters of the corresponding pose of the camera:

•

•

if the pose was calculated during a previous processing, select "Load a File" and
... next to "Georeferencing
select the image referencing file by clicking the button ...
file"

•

if the parameters are not in the Apero format, check "Enter them manually" and
enter pose summit and rotation parameters.

Set the scale parameters (see User orientation).

This type of absolute orientation only switches the calculated relative orientation in the known
pose frame. In the case of a survey divided into two blocks, you should recalculate all the poses in a
single block, because then there are tie-points between blocks that enable a more robust
triangulation. Moreover, if the pose estimation of the shared image is not very robust in one of the
two blocks (regardless of tie-points with the rest of the block), the relative orientation between the
two blocks will not be accurate, that's why this option is not recommended in this case.
GEOREFERENCING WITH GCP :

The GCP are points of known coordinates that are seen on the images.
The GCP file contains the terrain coordinates of the GCP and their measurement accuracy. It can be
in Apero xml format or in text format (you can use a spreadsheet program such as Excel or
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OpenOffice and save the file in csv format, separating the columns with a space (no tabs or comas).
The points are written by line, and the data written in this order :
groundPointName X Y Z dx dy dz
where dx and dy are the planimetric accuracy and dz the vertical accuracy of the point.
The image measures file includes the image coordinates of the GCP. The possible formats are the
same as for the GCP file (Apero xml format and text format). The data for each point must be
written in this order :
ImageName column line groundPointName
where column and row are the image coordinates of the point in pixels.
It is also possible to create new images measures by clicking the button . If a file has already
been imported, the new measures are added to the imported measures, otherwise a new file is
created. This opens a graphic input window ; for its use see part Using the mask drawing
window.

To enter a measure, select the image and the ground point to be measured and then click the point in
the image. To measure another point, select another image or another point and repeat it.
If measure is already done (when a GCP file was loaded for example), remove it first with button
before clicking a new measure.
When all points were measured, validate them by clicking
and save the file. If many points must
be measured, it is advised to validate and save them regularly.
GPS COORDINATES OF POSES SUMMITS :

As for georeferencing by GCP, it is possible to load data either directly in Apero xml format (select
"All directories (*)") or in text format (select "All Files (*)"). The poses are written by line, and the
data written in this order :
ImageName X Y Z
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so that the file can be converted to Apero format in folder Ori-BDDC.
d. Initiale orientation

This tab allows you to load relative orientations of some images to initialize the calculation,
independently of absolute orientation constraints (they can be added to initial GPS coordinates of
the summits for example).
This parameter is useful to compute the poses iteratively by subset images if the computation for all
images fails. A method consists in finding a subset of images that can be processed successfully,
then to add the other images one by one in the process while loaded the last obtained result in this
tab. Successive orientations are kept in directories Ori_InitialeX. This tab can be use to get a more
accurate result too by doubling the number of least squares iterations of the computation
To load an initial orientation, check the box and choose the right folder (choose. Ori-F to get the
last result).
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e. Previous auto-calibration

This tab allows you to improve the accuracy of the calibrations provided in the first step (Tie-points
search) to ensure the convergence of pose computing and improve its accuracy.
To do this, select a group of images (same system as to select the images to orientate) ; the poses
computation is run a first time on the selected images to re-estimate once the calibration, then the
computation is run a second time on all images to orientate using these new calibrations. Even if no
auto-calibration step is set up by the user, Apero re-estimates anyway the calibrations while poses
computing but all in a single step.
The images that are used for auto-calibration should be strongly linked with many tie-points to
ensure the convergence and accuracy of auto-calibration, that's why it is better to consider this step
during the shot (for example, add images to the survey specifically for auto-calibration, by
photographing a part of the scene that is well-textured and with different depths).
These images are not necessarily the same as the images to orientate at the second step ; indeed the
two calculations are independent.
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f. Multi-scale computing

This tab appears only if several different objectives are used.
By default, the calculation is done in one step (all poses and calibrations are estimated at the same
time, except if an auto-calibration is set up).
In the case where the images are taken with several objectives of different focal lengths (multiscale) and poses estimation do not converge in one step, it is possible to do it in two steps:
1. A part of the poses only is estimated (usually images taken with a short focal length lens)
2. The remaining poses are estimated by fixing the previously computed poses, and in a third
time, all the poses are re-estimated (using the results of steps 2 as initial value) to share the
errors.
To do this, check “Two steps orientation” and then select the image blocks to orientate first (the
blocks are separated by calibration and defined by the focal length used).
NB: The master image must belong to the blocks estimated in 1st step.
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g. Calibrations dissociation

If the final model is noisy even on well correlated parts and (especially) if the calibration (including
focus) has been changed between two images taken with the same objective (same provided initial
calibration), it is possible to dissociate calibrations for the corresponding images, that is to say in to
estimate a different calibration for each image.
To do this, check the corresponding calibrations.
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h. Tie-points parameters

“Filtering tie-points” reduces the number of corresponding points while keeping their distribution ;
this accelerate the following calculations (poses estimation, tie-points calculation in 3D and survey
view). If there is no images cohesion problems (a lot of tie-points were found), it is advisable to
check this box, otherwise it is better to keep all the found tie-points (NB: the survey view takes into
account tie-points filtering). The initial points are preserved, so it is possible to restart the poses
estimation after having unchecked this box to use them all.
After poses estimation, the terrain points corresponding to the obtained tie-points are computed and
can be displayed in the GUI ; if there are many images, this calculation can be long. You can skip
this computation by unchecking the box “Computing tie-points in 3D”.
It is also possible to ask Apero to directly export the tie-points and camera poses in a ply file
format, regardless of the previous option by checking the box “Export 3D tie-points to ply file”.

i. Process running
Compute ..
Click on Compute
Stopcomputation
computation in the
If the computation is too long, you can stop it by clicking the button Stop
progress window. The parameters values and the calculation progress are then saved to allow the
process restart at the same point.
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j. Results
The results are in the directory Ori-F (the intermediate results are in Orient and Ori-Interm
directories) :
•

computed poses in files OrFinale*.xml,

•

reestimated calibrations in files * _AutoCalFinale.xml.

Other created files contain provided settings :
•

the list of images to orientate : Images_a_orienter.xml,

•

the master image : Image_Maitresse.xml

•

the default settings depending on the shooting type and the process step : Apero.xml

You can view in 3D the results : position and orientation of the cameras, position of tie-points and
images bounding box ; see Survey view.

k. What to do if the processing fails...
•

If absolute orientation parameters were set, compute only relative orientation first, in order
not to add sources of problems.

We must look for the origin of the error in the file apero_outstream.txt.
•

•
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Images are not connected to the rest of the survey (" UNCONNECTED " or "Nn" = 0) :
•

restart the poses computation without filtering tie-points;

•

check the tie-points (see Tie-points view), especially those connecting the
disconnected image to the block containing the master image and already oriented
images ("Father", "Mother" images);

•

restart computation with a subset of images and try different configurations until you
obtain a result, then add iteratively each remaining image to the calculation while
loading the last result as initial orientation ;

•

if some correct tie-points were found and that more may be found (large overlap,
textured images), restart the tie-points search using a larger length of subsampled
image ; usually Apero requires that there are two pairs of images that link each image
to the block of already oriented images and that are linked by at least 8 correct tiepoints ;

•

otherwise divide the site into two or more blocks that must be processed separately
(keep tif images to not convert them again).

The calculation does not converge ("RESIDU LIAISON MOYENS :" increases or "=nan "):
•

quickly check the tie-points found, it is possible that there are many more uncorrect
than correct tie-points ;

•

restart the poses computation without filtering tie-points;

•

check the focal length of used objectives ; if it is a fish-eye or a very long focal
length objective, use a more accurate initial calibration or with all parameters set up,

•

or try to add an auto-calibration step to get a better initial calibration ;

•

if the shooting is multi-focal, perform a two steps calculation (multi-scale
computation).

•

•

restart computation with a subset of images and try different configurations until you
obtain a result, then add iteratively each remaining image to the calculation while
loading the last result as initial orientation ;

•

if there are important groups of mismatches in some couples of images (for example
when the scene contains moving objects or similar objects...) or if there are very few
tie-points with some mismatches in some couples of images, remove them manually
the mismatches removal tool (see part Tie-points view) ;

•

if absolute orientation parameters were set, check out them (GCP coordinates,
summits coordinates...)

There is an ambiguity and a parameter cannot be calculated ("ImProfAndL2App"):
•

If an absolute orientation has been defined (by plane, scale and direction), the mask
of the plan may contain too few tie-points and thus not be defined. In this case, we
must sketch another mask or not define any absolute orientation;

•

if absolute orientation parameters were set, check out their coherence

•

it is possible that the tie-points are aligned, too concentrated in an image or too few,
then see previous cases.

Even if the result converges, it is important to check in the 3D view of the survey that the solution is
correct before processing to the next step. Considering the wished accuracy, check out the residuals
value in apero_outstream file too (the value after « RESIDU LIAISON MOYENS : »).

5. Depth maps computation
From the main window, after getting the poses of the camera : Compute -> Depth maps opens a
secondary window for entering the parameters of the depth maps.
A depth map is a georeferenced image (it means that the 3D position of the camera is known) of
which each pixel describes the depth of the corresponding 3D point measured from the perspective
summit. In this case, the depth map is said computed in image geometry or frame.
Then a DTM (digital terrain model) can be computed like a depth map using an orthoimage ; the
depth described is the altitude to the ground. In this case, the depth map is said computed in ground
or euclidean frame.
Using the GUI, the depth maps can be computed :
•

either in the geometry of an image called the reference image (calculation of the depth of
each pixel of this image), the reference image corresponds to the point of view a laser
scanner would have, so there must be as many depth maps as needed to model the entire
scene. This calculation is well suited to convergent shooting because the entire scene is
represented in a small number of images and each part of the scene is seen by many pictures,
which avoids hidden parts and provides good redundancy of information to extract the
information of relief.

•

either in ground geometry, that is to say, in the geometry of a mosaic (an assemblage) of
quick orthoimages ; so that there will be a depth map for each block of images and the depth
map bounding box will be larger than the one of any reference image. This calculation is
well suited to relatively planar and extended scenes (walls, cliffs, aerial shooting...) : as the
shooting is rather stripped or parallel, it can limit the number of depth maps that are needed
to model the entire scene. It is also suitable for convergent shooting of relatively planar
surfaces because it allows the calculation of orthoimages.
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a. Depth maps list

The first tab lists all the already parametrized depth maps or DTM that will be computed.
To add a depth map, click on

.

It is also possible to not run the calculation of a parametrized depth map. In this case, select the
depth map, right click and select "Do not compute again". This is useful when you run the
calculation on a single depth map as a test and then on the remaining ones.
To delete a depth map, select the depth map and click on

.

If a depth map is removed, all associated data and results are erased from the GUI memory.
To modify a depth map parameters, click on

.

b. Images for the correlation

Firstly select the reference image, that is to say, the image from which will be calculated either the
depth map (in image geometry) or the orthoimage (ground geometry) ; it must be the central image
of a block of images that overlaps it and that either converge towards the same point (in image
geometry) or represent the same relatively planar surface (in ground geometry).
The button
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enables you to select the reference image in the 3D view (see Survey view) :

To select the reference image, select the tool , then click on the desired camera (it should be
colored in yellow and its name must be written below), right click in the view and click on "Select
this camera", so that its name is put in the tool bar. Finally validate this image with the button ,
otherwise it will not be taken into account.
Secondly select the images that will be used for the correlation.
•

In the case of a depth map in image geometry, they are all the images that represent the
same part of the scene as the reference image. They must surround the reference image so
that each pixel of the reference image has an homologous point in one of these images.

•

For a depth map in ground geometry, they are all the images that make up the orthoimage
and thus the depth map (with some redundancy).

It is advised to use images of the same resolution as the reference image in order to keep the
accuracy of the depth map.
It is also advised not to add too many images for the correlation in image geometry (3-4 are usually
sufficient), because each pixel of each image must be correlated with a pixel of each other image, so
that it increases the computing time very quickly ; it may be better to calculate more cards.
To add images, click on the button

and select one of three possibilities.

To remove images, select them and click on the button
SELECT A CAMERA FROM LIST :
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.

Ok .
Select one or several images in the list list and click on Ok
SELECT A CAMERA FROM 3D VIEW :

Select the tool , then click on the wished camera (it should be colored in yellow and its name be
written below), right click in the view and click on "Select this camera": its name is added to the
list in the tool bar.
To remove a camera, select it in the tool bar, right click, choose "Delete".
Finally validate this list of images with the button

, otherwise it will not be taken into account.

ADD THE BEST CAMERAS :

The four images that overlap and surround the best the reference image are added to the list (it is
advised to check the configuration of the cameras in the 3D view).

30/55

c. Correlation frame

This tab allows you to select the correlation frame :
•

either the frame of the reference image (depth map in image geometry)

•

either an euclidean frame (DTM)

In the case of an euclidean frame, the DTM is computed by default in the frame defined by the
absolute orientation.
To compute DTM in an other frame, check the box “Other frame than the absolute orientation
frame” (this is useful for depth maps of vertical objects like walls, cliffs...).

This specific frame can be already defined in an xml file. In that case, select “Load existing frame
... next “File”. The format be must be as the following :
parameters” then click on ...
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where Ori is the translation and Ox, Oy, Oz the rotation from the original frame.
Otherwise, the specific frame can be parametrized with the GUI. Then select “Define a new
frame”.

The required parameters are a mask of the horizontal plane, an axis in this plane and the direction of
this axis (for more details, see part User orientation in Poses estimation chapter).
Whatever enclidean frame is chosen, an assemblage table (AT) must be computed using the images
for correlation. This AT is a quick orthoimages mosaic that put together these images projection on
the horizontal plane of the frame at the mean altitude of the tie-points (this should be the
approximative position of the scene).
To save the parameters of the frame and to start the computation of the AT, click on "Compute
AT".

d. Mask
The calculation requires a mask of the interesting part of the scene so as not to map the background
(where the correlation is generally difficult, takes a long time and creates artifacts).
In the case of a deth map computed in image geometry, the mask is drawn over the reference image,
otherwise on the AT which corresponds to the DTM orientation and approximatively to its
bounding box.
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If a mask already exists :
•

select "Open an existing mask" ;

•

... next to "Mask".
import the mask (tif format) by clicking on the button ...

If the mask requires modifications,
•

Modifymask
mask ;
click on the button Modify

•

a drawing window opens to allow you to sketch the mask ; for its use, see part Using the
mask drawing window ;

•

check out that the mask is rightly saved in the file written in "Save the mask" line.

Otherwise, you can create a mask:
•

select "Create a new mask";

•

a drawing window opens to allow you to sketch the mask ; for its use, see part Using the
mask drawing window ;

•

once the mask is created, save it ; it is also possible to modify it as in the case of opening an
existing mask.

If the scene has depth discontinuities (it is when two objects of the scene are disconnected in
the reality but are seen side by side in the reference image), the model will presents artefacts due to
the smoothing algorithm used by MicMac. It may help to cut these discontinuities in the mask at
this step.
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e. Orthoimages

If the depth map is computed in euclidean frame, real orthoimages can be computed (they take into
account the ground relief described by the DTM and the hidden parts of the scene).
Then check “Compute orthoimages” and list above the images to orthorectify (in the same way as
images for correlation list). These images are not necessarily the same as the images for correlatin,
th only constraint is that these images have to be in the DTM bounding box.
By default, the orthoimages are computed at the same scale as the DTM (relative scale=1). A
different relative scale can be defined. Then fill the case “or relative scale” or draw manually the
same object in an image to be orthorectified (left list) and in an image for correlation (right list). For
more details, see part user orientation of the poses estimation.
Computing orthoimages and DTM at different scale can be useful for almost planar scenes. Indeed
the DTM requires redundancy, so, to limit the number of images, their resolution can be quite low
(a very precise DTM of an almost planar scene is usually not useful, except for micro-reliefs studies
like engravings). Then to get a very detailed orthoimage mosaic, specific images can be taken at a
very high resolution without considering any redundancy.
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f. Depth parameters

To reduce the computation time, the algorithm does not attempt to calculate the correlation
coefficients for all possible depths but only in an interval corresponding to the depths where the
scene is the most likely. This depth interval is expressed relatively to the mean depth of the tiepoints of the reference image (by default depth are searched between 1/3 and 5 times that distance).
For a landscape or a scene with large differences in depth, it may be useful to modify this
parameter.
If the scene has discontinuities (overlapping objects from the perspective of the camera but
separated in reality) or steep slopes (object faces that are seen very slanted from the camera point of
view), the pixels are hardly matched and smoothing done by the algorithm will create artifacts along
the discontinuities. To reduce the impact of smoothing in areas with high depth differences, set the
depth differences threshold over which smoothing weight will be changed (this value is in ground
units, the site must have been scaled during poses estimation).
The next parameter is the weight associated with distance variation between two points, it must be
set between 0 to 1 (1 is the default value where there is no discontinuities). For a distance variation
that is higher than the threshold (discontinuity), the weight will increase slowlier. When calculating
the best surface to model the scene (it is the area incorporating both the highest correlation
coefficients and the smallest changes in distance), for large distance variations, the values of
correlation coefficients will be privileged and depth gaps will be less constrained.

g. Parameters validation
Ok .. They can still be modified
To validate all set parameters for the current depth map, click on Ok
later in the first tab. If the button reminds hidden, a parameter is missing or is not saved.
Cancel .
Otherwise click on Cancel

h. Process running
Compute ..
Once all parameters are set up, click on Compute
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The calculation corresponds to the process of each depth map at different resolutions and at
different scales.
Stopcomputation
computation in the
If the computation is too long, you can stop it by clicking the button Stop
progress window. The parameters values and the calculation progress are then saved to allow the
process restart at the same point.
Normally the calculation for one depth map takes about 10-15 min (indicative value for 5
images of 21M pixels and a computer with 4 processors). If the calculation time becomes much
longer (especially if the progress bar has not moved for 10 min), it is possible that the process
cannot converge and may take much time. This can come from a not enough accurate
aerotriangulation or correlation problems (not enough textured scene, too steep surface ...). You can
watch the partial result of the calculation of the current map without interrupting it by clicking :
Help → Computing check-out.

This window is only accessible when the depth map computation is running.
It displays the shaded model of the depth map that is currently calculated and its correlation map
(the more the pixels in the mask are white, the more the correlation is correct). The depth map
displayed is tat he smallest scale (reduced 32 times) so as not to slow down the calculation ; but it
gives a good idea of the overall relief.
To update the view, click on
(not too often ...). If an image does not display properly, regularly
update the window until the images were calculated by MicMac and can be displayed (usually not
until the progress bar has reached 3%).

e. Results
The results are in directories Geo* :
•

computed depth maps in 16 bits *. tif format
(Z_NumX_DeZoomY_Geom+referenceImageName) : they are computed at several levels
of accuracy, they are not directly readable (see part Depth maps conversion).

Assemblage table and georeferencing files are in the folder TA*.
Ortho and hidden parts files are in the folder ORTHO*.
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The other created files contains the entered parameters:
•

masks *.tif and their referencing files *. xml,

•

the list of images that are used for correlation Carte_ *. xml,

•

the default settings depending on the frame : param-Geo*.xml

The results are not yet useful format. You can:
•

display point clouds in the GUI

•

convert the depth maps in shaded and colred images in 8-bits tif format

•

convert them into textured point clouds in ply format,

•

compute mosaics of the orthoimages that can be used to texture the point clouds.

6. Using the mask drawing window

This window lets you display and/or graphically draw parameters directly over the images :
•

segments for scaling (absolute orientation)

•

segments to define the x-axis (absolute orientation)

•

mask of the horizontal plane (absolute orientation)

•

GCP (absolute orientation)

•

tie-points

•

mask of depth maps

NAVIGATION TOOLS :
−

+clic to enlarge the image and center it around the mouse click ;

−

+clic to reduce the image and center it around the mouse click ;

−

+drag to move the image ;
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to return to the initial size of the image.

−
−

The tool
at the bottom right of the window allows you to enlarge and reduce quickly the
size of the window..

−

The image can be enlarged or reduced by changing the size of the drawing window too.

SKETCH TOOLS :
−

to draw a point, a segment or a polygon ;

−

to draw an extrusion polygon (to cut the mask) ;

−

to undo the last drawn point (with

−

to remove all drawn points over the current image ;

−

to redo the last drawn point (with

−

to validate all sketches (necessary otherweise nothing is recorded).

or

or

);

, even those remove with

);

Masks are drawn as union of polygons over the reference image or assemblage table.
The following two paragraphs concern only to mask drawing (horizontal plane for the absolute
orientation or depth map computation).

a. Automatic mask
To automatically obtain a mask a the scene, click on the button

.

•

If the mask contains holes, choose "Manage the holes in mask"

•

otherwise choose "Create a full mask"

The mask is created from the bounding box of the previously found tie-points of the image. The
holes are extracted from the triangulation and correspond to large sets of too large triangles. The
mask limits are then refined using the gradient of the image weighted with the distance to the tiepoints.
The mask of a textured object in front of a plain background suits better to automatic drawing than a
slightly textured object in front of a textured background as its tie-points are concentrated on the
object and not on the background.
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b. Manual mask
To sketch a polygon :

−

select tool

;

−

plot the polygon vertices with the mouse left click (the polygon is displayed in green) ;

−

close the polygon with the mouse right click (or double-click).

You can draw several polygon ; the mask then consists in the union of these polygons.
To cut a part of the polygon, draw an other polygon using tool

(the polygon is displayed in red) :

To capture more accurately the contours of objects, select both the tool
depending on the type of polygon to draw.

and the tool

or

This tool extract the shortest path between the last drawn point of the polygon path and the new
clicked point, this path being weighted by both the gradient of the image and the distance of each
point of the path to the segment connecting the extremities of the path. The number
to the
right of the tool increases the relative weighting of a image gradient compared to the distance to the
segment : the higher is the number, the more the path is closed to the segment connecting its
extremities. This tool works well only if the object to delimit has a different light from the
background.
When the mask is finished, do not forget to click
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to store it.

7. Save the project – Open and restart a previous project
When a step of the processing is done (tie-points are found, poses are estimated or depth map are
calculated), the parameters, current progress and results are automatically saved in the file
sauvegarde.xml.
To save the calculation (even stopped while running) in another file, select in the main window :
File -> Save or File -> Save As.
A project *. xml file is created, indicating the progress of the calculation, the results and the set
parameters.
To open a previously saved project, select File -> Open a computation.
Opening another project file erases the current processing data.
If the calculation was interrupted, you can restart it at the same step (it depends on the type of
processing in progress) by selecting Compute -> Restart. Otherwise you can go to the next step
from the recorded data.
It is possible to integrate external data to the GUI (in the same format as requested by the GUI) by
integrating them into a project file, which allows to bypass steps.
All the files that are created during the processing depend on each other ; if any has been
changed or renamed, make sure that they all remain coherent.

8. Results display
a. Tie-points view
This window lets you view the tie-points (see part Tie-points search). To open it, select View →
Tie-points view.
1. IMAGES PAIR SELECTION
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To select the pair of images to display, choose an image in the left drop-down list below the images,
then select the second image in the right drop-down list. The associated tie-points are displayed as
red segments.
Only the image pairs that are used in the poses estimation (those for which at least eight tiepoints points are found) are available.
2. NAVIAGATION TOOLS

To enlarge an image, select tool

and click in one of the image.

To enlarge an image, select tool

and click in one of the image.

3. MISMATCHES REMOVAL

If computed tie-points are mismatches and if the poses orientation fails, mismatches can be
manually filtered.
Firstly click on

to display the required tool bar (click again to hide it).

To remove a tie-point, select tool

and click near it (on either image of the couple).

To remove several tie-points, select

too and draw a frame around them.

To cancel the last removal, click on

(to restore it, click on

To save all the removals in the files, click on
further computations.

).

, otherwise they won' be taken into account in

Once the removals are saved, removed tie-points can't be restored (then restart tie-points
computation).
Removals are saved only in current files, that means that :
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•

if tie-points have previously been filtered during poses calculation, initial tie-points files are
not modified ;

•

reciprocally if tie-points have previously been filtered during poses calculation and if the
current files are initial tie-points files (when the poses estimation was restart without
filtering), filtered files are not modified ;

•

if, after mismatches removal, tie-points are filtered for the first time during poses
calculation, filtered files are modified too.

b. Survey view
This window allows you to view in 3D the parameters of the survey (position and orientation of the
cameras, calculated tie-points and images bounding box) after poses estimation. To open it, select
View -> Survey view in the main window.
1. SURVEY VIEW WINDOW OVERVIEW

The left side of the window represents graphically and in 3D the elements of the survey from the
parameters that are calculated during poses estimation.
•

The cameras are symbolized by the pyramids of which the top is the shooting summit and
the length corresponds to the camera focal length. At loading the cameras are directed
towards the bottom.

•

The tie-points are represented in 3D and textured with the image to which they belong.

•

The bounding box of the image (projection of the camera on the mean plane of its tie-points)
is represented by a rectangle.

•

The axes in the lower left corner of the view show the view rotations.

2. TOOL BAR USE

The tools set in the right of the window let you modify the display parameters.
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Translations
•

To move in the view, use tools

,

•

To initialize the view, use tool

.

,

and

.

NB : If components of the survey are moved out of the view perspective scope (especially out of the
depth interval), they will be hidden.
Zoom

To zoom in or out the view, use tools

and

.

Changing the window size enlarge and reduce the view too.
NB : If components of the survey are moved out of the view perspective scope (especially out of the
depth interval), they will be hidden.
To modify the view opening angle, use tool
models).

(especially useful to see inside

Rotation

To rotate the view, use tool

:

•

either by clicking on a side of the circle that corresponds to the wished rotation,

•

either by clicking on the circle that corresponds to the wished rotation and then by dragging
the mouse until the wished angle ; if you click in the middle of the icon, both circles are
selected.

rotations of fixed angle (click)

rotation depending a mouse dragging

Show/Hide elements

It is possible to show/hide the components of the view (cameras, tie-points or bounding boxes) by
checking/unchecking them in the part Display of the tool bar.
To display the images name, select the tool
and click on a camera : the name appears under the
mouse and the camera, its tie-points and its bounding box are coloured in red.
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NB: When the tool
is activated, it is not possible to navigate in the view with the mouse (but the
tools and keyboard short-cuts are still active) ; to allow navigation with the mouse, turn the tool
off .
To change the colour of the tie-points, use the tool
or textured with the corresponding image).

(monochromatic, with hypsometric colours

3. NAVIGATION IN THE VIEW WITH THE MOUSE
•

The main button of the mouse rotates the view: for this, click on the blue circle that
corresponds to the desired rotation (the light side is the part in the foreground of the scene),
maintain the click and drag the mouse in the desired direction.

•

The wheel of the mouse zooms.

•

The secondary mouse button translates the view in the both directions that are parallel to the
screen.

4. KEYBOARD SHORTCUTS
Translations et zoom with the keypad
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8

Move to the top

2

Move to the bottom

4

Move to the left

6

Move to the right

+

Zoom in

-

Zoom out

7 or 9

Move to the front

1 or 3

Move to the back

0

Initialize

Translations et zoom with the default keyboard

h

Move to the top

b

Move to the bottom

g

Move to the left

d

Move to the right

+

Zoom in

-

Zoom out

p

Move to the front

l

Move to the back

o

Initialize

Rotations

↑ and ↓

Rotate about view x-axis

←and ↑

Rotate about view y-axis

Space and Alt (or Alt Gr) Rotate about view z-axis

c. Points clouds view
This window is opened when you select View -> Points clouds view in the main window.
This is the same window as the survey view ; only point clouds are added. It is possible to
show/hide each cloud or display it in hypsometric colours, textured or monochrome.
If there are many clouds, the loading can take some time.
The resolution of the clouds depends on their display distance to the user.
Points clouds are by default textured with either their reference image if the corresponding depth
map was computed in image frame, or with the assemblage table if the depth map was computed in
ground frame. To texture a points cloud with the mosaic of orthoimages (ground frame only), this
must be computed before points clouds view loading. Otherwise restart the GUI to take it into
account.
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9. Depth maps conversion to 8 bits tif format
The previously calculated depth maps are encoded into 16 bits and are therefore not usable. It is
possible to convert to 8 bit tif images them by selecting Conversion → 8-bits depth maps.

The depth maps are computed at different levels of accuracy (this is indicated by the particle
"DeZoom+x" in their name).
•

Select in the list the depth maps to convert;

•

Select the conversion options:
•
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Show conversion displays the result at each stage of calculation;

•
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•

Hide background uses the mask with the same level of accuracy (previously
calculated) to ignore the background during conversion and gives it a value of zero
(the background was not taken into account when calculating the depth map, so any
value was assigned to it);

•

Unquantify smooths the depth levels of the depth map;

To set additional options, click on ”More options” :

•

Sources number set the number of sources of light ; they are spread uniformly all
around the image

•

Shade mode allows you to add local shading (Local) and global shading (CielVu)

•

Relief exaggerates the relief ; it is multiplied by a coefficient to make it more visible
after shading and coloration;

•

Images output specifies the names of the 8-bit images (full path) to keep it generic
(if more than one image is converted) ; use the keywords (do not forget the '):
•

'carte': number of the reference image,

•

'repertoire': data file,

•

'dezoom': the image scale,

•

'etape': step number in the depth map calculation ; step 6 and 7 have the same
scale

•

'parametres': parameters entered in this window

•

Anisotropy changes the direction of the main light: if it is zero, the shading is
isotropic (all directions are equivalent), the closer it is to 1, the more the directions
that are close to the "north" of the image have an important role ; it must be set
between 0 and 1;

•

Hypsometric colors changes the color dynamic (the number of colors) and the color
saturation of the hypsometric colors of the shaded image;

•

Bounding box restricts the calculation to a frame that must be drawn in the below
image ; to do this, click on a corner of the red rectangle and drag it to the wished
size;

•

Often the values at the border of images are noisy (or even meaningless) ; if they are
high values, they have a strong influence on the shading ; “Border width” applies
the minimum value of the image to the border of width the parameter value, so that it
does not affect the shade.

The shaded depth map at lower scale is shown at the bottom of the window ;
remember to
check in the console if there is no error messages about the validity of the parameters before
running the calculation ;
Compute .
Click on Compute

→
The converted depth maps are put by default in the directory Geo*/Conversion.

10. Depth maps conversion in 3D models (points clouds)
To convert the depth maps in 3D points clouds in ply format, select : Conversion → 3D models in
the main window.

48/55

This window displays all the depth maps at all calculated scales. To convert a set of depth maps,
Compute .
simply select them and click on Compute
Available options are :
•

Subscaling interval is used to calculate only one point per interval without changing the
scale of the cloud.

•

Output files format depends on the application used to read them ; to read them with
MeshLab on Windows, check Binary file and uncheck Xyz file, to read them with MeshLab
on Linux, uncheck Binary file and uncheck Xyz file.

•

Relief exaggerates the relief ; it is multiplied by a coefficient to make it more visible

•

Image dynamic modifies the histogram of he texture image

•

Bounding box allows you to export only a part of the clouds (for its use, see part Depth
maps conversion to 8 bits tif format)

•

Noisy points filtering is an automatic filtering of points that obtained a low correlation
coefficient and that are on high slopes ; the goal is to filter artifacts from depth maps
calculation that come from depth discontinuities. The result is better for well-textured scenes
with very high slopes ; usually all noisy points can't be filtered and a manually filtering in
anyway required, but this enhance the cloud display.

Other options are accessible if you put the mouse on the corresponding line (without selecting it)
and right click on it :
•

To apply a different texture image as the one proposed, choose Other texture image and
select the wished image (it is applied at all scales of the selected depth map).

•

To save the ply file in another directory than the one proposed, choose Other saving
directory, and select the folder (which is also applied to all scales of the selected depth
map).

•

To filter out noisy points (especially for scenes including depth discontinuities), choose
Noisy points filtering mask, open a mask (either an existing filtrering mask, otherwise the
mask used to create the depth map), eventually modify it and save it. The mask is
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superimposed on the correlation map to facilitate the detection of noisy areas (low
correlation coefficient are darker areas).
If the depth map was calculated in the ground frame, the default texture image is the assemblage
table. So remember to calculate the orthoimage mosaic before converting the depth map and to
select the mosaic as texture image.

11. Mosaics of orthoimages computation
To compute a mosaic of the orthoimages that are computed with the depth maps, select :
Conversion → Orthoimages.

Compute . Only the orthoimages whose
Select which orthoimages set to mosaic and click on Compute
corresponding depth map was calculated with the "Compute orthoimages" option appear in the
list.
To equalize radiometrically the orthoimages before the mosaic computation, check "Radiometric
equalization".
The result is an image in tif format called Ortho-Eg-Test-Redr.tif or Ortho-NonEg-Test-Redr.tif and
put in the corresponding folder ORTHO*.

IV Contact
For bug reports, comments on the GUI, proposals for improvements or questions regarding data
acquisition, use or application of the GUI, please send an email to isabelle.clery @ ign.fr
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ANNEXE DATA ACQUISITION
1 Camera setting
•

The images can come from any type of camera. But the aesthetic quality of the pictures (and
textured model) and the accuracy may depend on the quality of the camera (usually the
precision mainly depends on the shooting).

•

If possible do not set the auto-focus and set the focus once for all at each change of objective
(indeed, if the focus changes, the objective calibration is different and this should be
indicated in GUI). Therefore ensure that the depth of field is sufficient and that whole scene
is clear.

•

Minimize specular highlights (metallic objects) and scenes with changing backgrounds too
(trees, crowd). Avoid even the flash and moving light sources (instead use fixed projectors).
The shadows are not annoying and may even help the algorithm (except in case of
saturation), but they should not move.

•

A change in brightness does not affect the calculation of the 3D model while there is no
saturation or expanded black areas, however the different clouds that constitute the 3D
model will have different radiometries (it is recommended to equalize all the images that are
used as "reference image" in depth map computation just before the conversion to ply files).

•

It is recommended not to use compressed jpg images. If this happens, adjust the size of the
sensor in the GUI when creating initial calibrations.

•

The algorithms only work on textured scenes (stone, colorful material, earth), so avoid
monochrome plaster, uniform colors on smoothed surfaces. If the scene contains a wide
non-textured area, it will appears very noisy in the 3D model.

•

The aerotriangulation of the images taken with the long focal length objectives is not robust
and often diverge ; to avoid this take pictures of the same part of the scene with a short or
medium focal length objective.

•

In addition, if the images have very different scales (images that are taken with objectives of
short and long focal lengths, or that have a very different distance to the scene), it may be
useful to add images of intermediate scale so that the algorithm finds enough tie-points
between the two images blocks.

2 Shooting protocol
The shooting must obey two constraints :
•

Calculating a depth map for every wished point of view (step MicMac)

•

Referencing all the depth maps (thus all used images) in a single frame to merge all the
point clouds (step Apero).

Various case studies are presented on the website of the MAP laboratory :
www.tapenade.gamsau.archi.fr (the site is still under construction).

a. Convergent shooting
A Shooting protocol for one depth map
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A depth map corresponds to all points of the scene seen by a "reference image", which means that
each pixel of the image will be computed in 3D (it is the same principle as a laser scanner that is
sited at the same point of view as the reference image and that has the same opening angle as the
used objective).
The density and the resolution of the point cloud are directly related to the resolution of this
reference image ; to get a very accurate point cloud just shoot closer to the scene or use a longer
focal length, thus this technique is adaptable to a wide range of resolutions.
To obtain the missing 3D information from the 2D images, we use a set of images, taken with the
principle of stereoscopic ; this means that any part of the scene to model must be seen in at least one
other image than the reference image (it is not necessarily the same for the whole scene).
If a pixel (that is included in the mask) of the reference image is not seen on another image, it will
be correlated with any similar pixel by the algorithm or relegated by default to the background ; in
all cases, this will create a noisy 3D point (however if it is insulated it is usually recovered by the
smoothing of the surface).
Experience shows that the configurations in cross (5 pictures) or T (4 images) can prevent these
problems of hidden parts.

Example of convergent shooting configuration for a depth map.

The cross (or T) may be in the horizontal plane (take care of the focus) or in the vertical plane.
(The ambiguities are due to linear features that are parallel to the base line connecting two camera
poses. They are removed by taking a picture outside this line)
Note that the greater the distance between the cameras is and the more accurate the model will be.
However, the correspondence between the pixels of the reference image and those of other images
is done by correlation, that is to say, by similarity of their neighborhood. If the object is too
distorted from an image to another, there will be no matches. A solution for models that require
high accuracy is to inserts intermediate images to distribute the deformations. A possible
configuration is as follows :
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Example convergent shooting configuration for a depth map with a high level of depth accuracy

Note that the more there are images and the more accurate the depth map will be, but the calculation
will be much longer.
B Shooting protocol to link he depth maps
To fully model an object, simply go around it and create as many depth maps as necessary to
modelize every sides of the object (the number depends on the complexity of its shape). Otherwise
if the object is almost planar, divide it into blocks and create a depth map per block.
A method to ensure the completeness of the model is to take, before the final shooting, a picture for
every future depth map and to check that the entire surface of the object is visible in these images.
To put every point cloud in the same frame, the pictures that are used to compute the depth maps
must be linked with photos in between.
The images are linked to each other by tie-points : they are points of interest (areas of high gradient:
spots, corners of objects) that are matched with a point of interest of another image using the
likeness of their neighborhood. If the computed tie-points are correct, both points of the pair point at
the same spot.
To ensure the connection of an image to another, they must overlap enough (at least 60% of the
image for parallel shooting, an overlap of 80% is usually advised for convergent shooting). In
addition, parts of the object are distorted from an image to another as they are seen from a different
point of view. Finally, a rotation of 10 to 20 ° (depending on the curvature of the object and its
shape complexity) between each point of view is sufficient. Note that it is better to take too many
photos than not enough because it is rarely possible to complete the shooting in the same conditions
some time later but it is easier to let the calculation run a little more time.
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Example of a full convergent shooting configuration to fully modelize an object

This parallel shooting configuration can also be used for fully modelized objects that are larger than
camera field. In this case, for every point of view when this problem happens just make a small pan
shot instead of a single image. During the processing, either the reference image is not split, then
you will have to include all the images that are used for this point of view in the computation,
otherwise you can separate point of view in several depth maps or create a single map from a
mosaic of the pan shot picture (computation in the ground frame).

b. Parallel shooting

Example of a full parallel shooting configuration for a wide, almost planar scene
(a single picture can be taken from each point of view, it depends on the scene accessibility and on the
number of possible points of view)

This type of shooting is mostly used in aerial photogrammetry or for buildings facades. Indeed, it is
easier to use a convergent shooting in terrestrial photogrammetry because the relief is usually more
complex and therefore presents more hidden parts ; thus a convergent shooting enables a greater
redundancy and thus greater accuracy, but is easier to obtain in terrestrial photogrammetry than
with an airplane.
Parallel shooting is done by traditional strips, with an overlap of 80% between images and 20%
inter-band.

c. Auto-calibration
If the calibration parameters of the used objectives are unknown, a specific shooting can ensure the
convergence of the poses calculation.
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Simply take some pictures (using a convergent shooting as for a depth map) of a very textured
scene that contains high differences in depth (wall corner …) to ensure the precision of the focal
length estimation.
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